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Content Acknowledgement

The text in this book is comprised of content assembled from the online Plone Manual, found at http://npower.learnplone.org/ and The Definitive Guide to Plone, by Andy McKay. We recognize and appreciate that such material is available and encourage you to seek these out on your own when you need assistance.

Overview of Plone

Plone is an open source Content Management System (CMS).  
“Open source” means that Plone is licensed under the GNU General Public License, the same license used by Linux. This gives you the right to use Plone without a license fee, and to improve upon the product.
A “Content Management System” is a tool that makes publishing content to your website easy by separating a website into layers:

· Content:  The text, pictures, links and other content you enter into the site. In general, content appears in the main center section of the page.
· Graphic design and layout:  The appearance of your pages is part of a “skin” that is defined separately from the content you enter. This way, your whole site has a consistent appearance, and you don’t have to worry about formatting every page.
· Content-management features and custom code:  Plone itself provides many features, such as the search box, the calendar, and the ability to log in to edit, review and publish content. Your site may also include custom features, such as special content types for entering and displaying information.
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Unlike many website systems, which require a web expert to make changes to content, using a CMS like Plone allows you to update your content separately from the underlying code or design.

What NPower Seattle typically does to create a site

Each website we develop requires design and configuration in preparation for your organization’s content entry and rollout. NPower Seattle web experts have followed several steps to prepare your site:

1. Configured Plone site properties and navigation tabs

2. Set up users and security settings

3. Created a “theme” that determines the appearance of your site (CSS file(s))

4. Coded any custom features or data types your site requires

5. Created Folders to organize content

6. Added sample content to give you a head start

Now it’s your turn! Before a site is ready to launch, you need to log in and enter and edit content across the whole site. When it is ready, we make it available to the world at your web address.

Goals of this class: What we’re trying to teach you
This class assumes that you have, or soon will have, a Plone website established for your organization. Further, it supposes that after the site is complete, you will be responsible for maintaining a page or some content on your website. First-level web editing requires a basic understanding of how your CMS works; enough to edit existing content and set up a new page within your existing site. This class will cover those topics and include some hands-on practice as well. 
Structure of class: How will you be participating?

This class involves three types of interaction with Plone. 

· You will observe the instructor administering Plone to demonstrate key concepts. 

· You will connect to a sample website and log on to Plone as a site member, performing several of the tasks commonly required for updating content. 

· You will log on as a manager to gain an understanding of the functionality for adding new content and organizing your site.

We hope that this classroom experience will help you become confident in the basics of keeping your site current, help you to assist others with using Plone, and provide you with the understanding and vocabulary to communicate effectively with other technical support groups such as NPower Seattle.
Topics covered
The Plone Foundations training begins with an introduction to the steps of basic editing to familiarize you with using your Plone website, moves on to cover several next steps in creating new content, and finishes with discussion of where to go next for more information. We’ve also included some “extras” on additional administrative functions around organizing information on your site.

· The Getting Started section covers the basic steps involved in logging in, editing existing content, and saving your work. This material is covered in the Plone Manual site at http://npower.learnplone.org/ under “Quick Start” 

· The Adding New Content section moves on from the basics to cover adding new content, working with images, and creating relationships between pages. This material is covered in the http://npower.learnplone.org/ site under “Full Tutorial”

· The Extras – Administering Your Site section is included here in the event that there is time to go on to the next level of Plone site management. 

· The Where to Go Next portion of the training covers resources available to learn more, including web and print resources. 

Getting Started in Plone

Logging In 
Your website may or may not have a “Log In” button or link that you can click to log in. If it does not, you can log in by adding /login_form to the end of your website's URL.  
So for instance, for http://www.npowerseattle.org ,

we would log in at http://www.npowerseattle.org/login_form. 
In the resulting form, type in your user name or password (for the sample training website, follow the instructors instructions). Your user name is most likely the portion of your email address before the “@” sign, and often your first name plus the first letter of your last name. (For example, georgeb.) If you forget your password, follow the instructions on the screen to have it emailed to you.

Editing an Existing Page
Go To The Page
From the welcome screen that comes up when you log in, make your way to the page you wish to edit. To do so, use either 1) your top (horizontal) navigation, or 2) click on the ‘contents’ tab to view all folders and documents and then make a selection, , or you can search for it using the search box.
Note: There are different kinds of “pages” in a Plone site. The ones we will be discussing here are ordinary pages, which make up most of your website. Be sure that the page you are looking for isn't a news story, an event notice, or any other more specialized kind of page.
1)Your site navigation (top)
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2)’contents’ tab (Plone user interface) 
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3) type the name of the page in the search box:  
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The Parts of the Page
When you select a page, you’ll be taken to the “view” tab. This tab shows you what the page will look like. The parts of the page that you have access to are the ones enclosed by the green border. 
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To access the content and edit the page, click the “edit” tab. Once you’re on the edit tab, you’ll see the page divided into different fields, which are discrete chunks that Plone divides a normal web page into. The fields appear here with some explanations. 
Here is some context for the four different fields:
Title: This appears in the title bar of the browser window, as the headline of the page, in the navigation; basically any time a page is referred to, the title is used. This field is required; it should be descriptive and not too long.
Note: The red square that appears to the right of the Title label indicates that it is required; Plone will protest if you leave it blank!
Description: This is a short lead-in to the document -- usually the introductory paragraph to the page. It appears after the headline of the page but before the body text. While this field is optional, we strongly encourage you to use it. It also appears in search result listings to provide additional context, and as a pop-up when you hold your mouse over the left navigation.

Body Text: This is the main part of the page, and the part that allows you to use the selection of formatting buttons that is the subject of the next page.

Editing Body Text 
Editing text requires using a graphical editor, a tool that allows you to format the main body of the page NPower-designed sites are set up to use TinyMCE, the latest graphical editor for Plone.

Edit the Page
An extensive toolbar appears above the editing area of the body text.  Many of the functions it performs are self-evident, but a few are not. Some you will use every day, and others far less often.  A brief description of a tool's function appears if you hover your mouse arrow over the button.  
Here is quick synopsis of the editing buttons in TinyMCE, in the order that they appear.
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	The style menu.  Allows you to choose a paragraph formatting style for your text.  The choices in this box will likely be customized for your website's design template.  However, in a default Plone setup, "Normal" is used for body text, "Heading" is used for major headlines and "Subheading" for secondary headlines.

Styles in the "Text" section apply to full paragraphs, while those the "Selection" section can be applied to individual words within a paragraph.

Experiment with the different styles to get a feeling for how they behave.
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	These buttons toggle whether the highlighted text is bolded or italicized. These are similar to the formatting commands in a word processor.
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	Text alignment (left, center, right justified). These settings apply to an entire paragraph. Again, similar to your word processor.
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	Ordered and bulleted lists. We encourage you to use these instead of trying to manually insert numbers or bullets. To stop adding items to a list, delete the last bullet/number or hit enter twice.
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	Increase/decrease indent. Best used for excerpted text.
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	Toggle full-screen mode, which expands the editor to fill your entire screen.  Can be handy for working on larger pages.
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	Insert a definition list, which is a way of formatting lists.  A definition list has alternating lines that are boldfaced and indented, and looks like this:

Defined Term 

Definition text goes here 

(This is probably not something you'll use very often.)
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	Insert an image. This button will open up a "drawer" which will allow you to browse the contents of your site to find the image you want, or upload a new image.
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	Insert or remove a link. This could be either to another page in your site (an "internal link") or to a page outside your site (and "external" link).
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	Insert a table. Tables are a little hard to format using this tool (the interface is not very intuitive), although sometimes it is adequate. If you need a complex table, do it in HTML or ask NPower for assistance.
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	Undo and redo edits done before the last time you saved. These buttons work with varying levels of success. Note that there is a more involved site-wide undo feature discussed in the web-based manual.
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	View and edit the HTML code of the page. This can be useful if you need to make some more technical adjustments to the code. Knowledge of HTML is required.
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	Quick save. When you are making a lot of edits, it's a good idea to save often. This button allows you to save your work quickly without exiting the editor, so you can get right back to working on your document.


A Note about Formatting

Most of the look and feel of your website is controlled by style sheets (CSS) behind the scenes. To keep your web pages looking consistent throughout the site, you should use minimal formatting options within your content. In general, there should be no need to change font sizes or colors. You may occasionally want to bold or italicize a phrase.

Bold or Italicize text: Highlight the text you want to emphasize. Use the toolbar, just like in MS Word, to make the text bold or italic.

Line Breaks: In general, you should be able to add a line break by simply using the Enter key. Occasionally, you’ll come across a situation where the line break you entered while editing content displays as a line break in View mode, but not in Edit mode. To resolve this, click the Enter key as usual, and then hold down the Shift key and click Enter again.

Inserting Images and Links
TinyMCE uses a type of popup window to let you insert internal links and images into a page. The tool also allows you to upload images directly and to choose where on the site they should be stored.
Inserting and uploading images
To insert or upload an image, click on the image button in the TinyMCE toolbar: [image: image20.png]





This will open TinyMCE's image manager, which looks like this:
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This screen, which is similar to the Windows Explorer or the Macintosh Finder, will allow you navigate through your website. 
Click Home, then Images to get to your site's Images folder. (Or go to another location where the images are stored.)  You'll see a listing of available images in the folder.

[image: image22.png]Insert/edit image.
Plone3 Out of the Box

Libraries Image list
Image list

@ Home

@ Current Folder (D Events

Search (2 Images
(2 News

A search

(0 users







A) Inserting: To insert an image, click it, and you'll see the following options in the right-hand panel:
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You can "float" images to the left or right by choosing "Left" or "Right" using the Alignment dropdown.  
"Inline" images will simply be inserted into the middle of the text, which will break above and below the image.
B) Uploading: To upload an image, click the Upload... button and the right-hand panel will show an image upload dialog box:
[image: image24.png][~ Upload file
File

[1Users Jesses ictare (Browse.)

Title
[Nap time

Description
[A big orange cat napping
lon the couch.

© Upload







Browse your hard drive to find the image file.  Give it a title and description if you like and click Upload. (If you don't enter a title, the filename will be used as a title.)

Tips for uploading images:

1. Make sure your images are "web-ready" -- that is, cropped to the appropriate size and saved as JPEGs (photos) or GIFs (graphics). Plone does have some size options: however, these alter the ‘display’ size (amount of space occupied on the page) but NOT the file size (amount of storage space occupied on the server).  

2. Make sure your images have "web-friendly" names -- no spaces!  For example, "nice-screenshot.jpg" rather than "nice screenshot.jpg" 

You'll now see your new image available for inserting into your page, which you can do as before by clicking "Insert":
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Inserting Links
TinyMCE uses a type of popup window to insert links to other pages in your site. Select the text you want to hyperlink, then click the [image: image26.png]


 button to insert a link.  It will open a drawer that looks like this:
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From this screen it is possible to add links to several different types of target. The process of choosing the thing you want to link to begins in the left section, labeled "Libraries", and we'll cover each option below.

Inserting Internal Links

To link to another page within the site, you will navigate to it starting either from the root of the site (choose the "Home" link), or from the current folder you're in ("Current folder" link). Here I'm preparing to link to the "News" folder:
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The title and description of the page you've selected are shown in the "Details" box on the right.

From this screen, you can navigate around your site.  When you find the page that you want to insert the link to, highlight it and click"Insert".

Inserting External Links

To link to a page on a different website, use the "External" option and type in the URL. You can click "Preview" to actually load the target site into the Preview window to verify you've got the correct URL:
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Mail Links

Email links are created with the "Email" option in the "Libraries" menu. Enter the email address you'd like the link to trigger a new email message to, and optionally a Subject, which will auto-fill the subject line of the email:
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When the user clicks the resulting link, the To and Subject fields will be filled out correctly:
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Saving Your Work 
Be sure to save your work before clicking any other links! 
The Save button is at the bottom of the page. Click the Save button to commit your changes. You'll be returned to the view tab where you can see how the document will be shown to users; to edit it again, click the Edit tab.

Project 1 – Editing and Saving Your Work

In this exercise, you’ll register, log in, and edit an existing page. You’ll create hyperlinks and insert an image on the page.

1. Click “Log In”, fill out the form, and click OK.


2. Click the “Home” tab (or your sites Logo/Name in the banner section) to move to that page.

3. Click the Edit tab.
The ‘Edit view’ for the page appears, with fields for Title, Description, and Body Text.

Now you’ll add a link to an external web site.


4. In the Body Text box, type: “Visit NPower Seattle!”

5. Click the Link icon [image: image32.png]


 in the editor toolbar.

6. Choose "External" in the "Libraries" menu, then after “http://” type “npowerseattle.org”

7. Click Preview then Insert.

Next, you’ll add text and link to another page on the site.


8. Click below the existing text and add the following paragraph:
    Start by reading our latest News.

9. Select “News” and click the Link icon [image: image33.png]


 in the editor toolbar.

10. Click "Home", click “News" and click Insert.

Next, you’ll add an image to the right of the text.


11. Click at the end of the text and press Enter.

12. Click the Image button, click Current Folder, and then click Upload file.

13. Click the Browse button, locate an image that you want to insert, and double-click it.

14. Type something in the Title box, and then click Upload.

Note: You can also insert images that already exist on the site. When you do, you can specify whether the image should display inline (as this image does), or to the left or right of the text.


15. When your image has uploaded, click Insert.

16. When you are finished editing, click the Save button.
The page displays in the View tab, showing your changes.

This page is currently a “Private*” which means that visitors to the site will not see your changes. Later on, you’ll submit the page for review, then publish it on the site.

*If you have an existing Plone website, the ‘version’ your site was created in may vary with respect to the default ‘status’ when a new page is created.  Most earlier versions (prior to Plone 3.0) use “Public Draft” as the default, which IS viewable by the public.

Adding New Content

Adding New Pages and Other Content

The first thing to realize when adding a new page to your site is that Plone has more than one kind of "webpage".  The most generic type of page -- the one that will comprise most of your site -- Plone calls a “page” (or "document" in versions before 2.1). 
Plone uses other kinds of pages for more specialized purposes, and each one has at least one feature that sets it apart from the others.  You can see the full list of kinds of pages you can add to the site by logging in and looking at the Add Item or Add to Folder dropdown menu on the page.  

Once you're a site member, a folder is created for you where you can store content. Of course, you can add content to any folder that the site administrator has given you the right to do so, but by default every user can add content to their member folder.

Each type of content you can add is distinct, and you can edit and view it in different ways. For this reason, Plone references each type of content differently; for example, you can add images, links, documents, and so on. 

Plone provides the following content types:

· Page (or Document): This is an item that presents some static information to the user. This is the most common type of content added and most closely represents a typical Web page. Use this to add a regular web page.

· News Item: This is a document that's to be shown under the news tab (for example, a press release). Use this when in the News folder to add a new News item.

· Link: This is a link to another item, which may be internal or external to another Web site. 

· Image: This is an image, such as a .gif or .jpeg file. Use this to upload an image to the images folder, for later use.

· Event: This is an upcoming event, meeting, conference, or other event. Use this when in the events folder to add a new event.

· Folder: This is like a folder on a hard drive; this is a folder for putting content into so that it's easy to find later. this to add a new sub navigation item.

· Collection: This is a grouping of other content. This is essentially a saved search criteria that you can reuse later. 

· File: This is another piece of content such as a movie, sound clip, text file, spreadsheet, compressed file, or anything else you'd like to upload. Use this to add an attachment.

Your web site may contain also contain custom content types, such as a Business Listing folder and Business. You add this type of content in the same way as a page or other standard item, but the fields you fill in are different.

How to Add a New Page

To add a new page, first be sure to navigate to the folder where you want to insert the new page. Check the breadcrumbs (directory displayed in the address bar at the top of your browser, or the location cues indicated in your sites navigation structure) to be sure you’re in the correct place.

Once you’re in the correct folder, click the ‘add new…’ dropdown, and choose from the drop down list, for example, “page”. 
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Fill in the appropriate fields with your content. For example, in the Title field, enter the title you want to display at the top of the page. For an event, be sure to set the date and time properly—the event won’t show up if it occurs in the past. 

When you are finished editing, click Save.

Submitting, Reviewing, and Publishing

When a page or other item is first created, its status will be “Private”. This means that only the user who created the page and site Managers will be able to see it.

Submitting

When you add and save a page or other content item, it doesn’t necessarily appear on your site. Content from site members is often reviewed by a manager before it is published.

At the upper-right corner of the editing area, you’ll notice that the status of a newly added page is “Private”. Until the content is “Published,” it won’t appear to the public. To change the status of your new page, click the "state" menu to display the list of available states:
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To submit an object for review, select Submit for publication from the drop-down menu. If you have been granted the appropriate permission by the site administrator, you can click Publish to make the content available immediately by selecting Publish.

When an item is submitted for review, it moves into the "review" state. This is an intermediary state between private and published. It allows for the review of content by users of your site with the reviewer role, before it goes live for the entire world to see. After you've submitted the content, you'll notice that the content is now in the review state by looking at the box in the top-right corner. You'll also notice that there's no longer an edit tab.
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In the example above, the content has been submitted for review, the state has changed to "Pending review".

Reviewing

If you're a reviewer, then in the right column of the home page or on your dashboard, you may see a new review list when you first log in. This is a list of the items that have been submitted for review and need reviewing by you or another reviewer.
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The review list will appear on the right when you log in as a user with the review role and there are items to review. You can tell you're logged in because your name will appear in the member bar. The review list gives a list of items to review. Click the document to open the item. At this point you essentially have the following choices for this item:

Make it private again: Return it to a private state by selecting Send back (or Retract if you are the person who submitted it for review) from the drop-down choices. This will move the content back into the private state and assumes that as a reviewer you're not ready to have this published. Usually you may want to click the Advanced option to open the comments form and add some comments stating why you're rejecting it.

Approve it: Approve it by selecting Publish; this will change the content into the published state. This will make the content publicly available.

Do nothing: Leave it by doing nothing. This leaves the content in limbo but sometimes happens when you need to check information or talk to others. Eventually you should return to do something with this content because it'll continue to show up in your list of items until you make one of the previous actions.

Edit it: Edit it, and then perform one of the previous actions. 

Once you've moved content out of the review state by publishing or retracting it, it will no longer show up in the review list. Of course, this assumes you do have someone as a reviewer for your site; this usually (although not necessarily) is also the user who created the Plone site as an administrator.

Project 2 – Adding and Publishing a News Item

In this project, you’ll add a news item to your site, save it, and submit it for review.  You’ll then review the item and publish it so it appears in the News listing.

1. Click the News tab.

2. Click Add Item and then click News Item.

3. Enter a Title and Description.  For example, your title might be “Local Business is Booming.”

4. In the Body Text box, type the news. Try to format your text with bullets, headings, and bold or italic text.

5. Click Save.

Your new page is now “Private.” You want to submit it for others to review.


6. Next to State, click “Private”, and then click Submit.

Your page now has the Pending state, and it appears in the Review List at right. Any user logged in with “reviewer” permissions can see this list.  

Suppose you want to make sure the news item appears only for one month on the site (after that, it isn’t news!). Plone will automatically stop displaying content once it has expired.


7. Click the Properties tab.

8. In the Expires field, select a date a month from now.

9. Click Save.

Next, you’ll publish the item.

10. Click Pending, and then click Publish.

11. At the very top of the page, click Home. 

Your news item appears in the News listing at right, and is available to site visitors.

Extras – Administering Your Site

Organizing Content

So far you've seen how to add and edit content in a Plone site, but without clear organization this can become a mess quite quickly. You have two main ways of organizing content: folders and topics. 

· A Folder is the simplest and most powerful mechanism for organizing content and works just like a folder or a directory on a computer's hard drive. A Folder can contain any item of content; content can be copied and pasted between folders, and of course Folders can contain other Folders.

· To organize content that's spread all over a site, a more sophisticated and less-used tool called a Collection is available. A Collection searches your Plone site and finds all objects that match a certain criteria, allowing you to group lots of disparate content.  

In this training we cover using Folders.  A Folder is just like a folder or a directory on a hard drive, except that the Folder and its contents exist inside Plone. When you need to categorize content or make things a little clearer, you can group items and place them in a Folder.

Creating a Folder

To add a Folder to your site, select Folder from the drop-down list. This will add a Folder and take you to the edit properties page for that form. A Folder has just three rather simple attributes that a user can edit: Name, Title, and Description. 

Viewing the Contents of a Folder

The Folder has the concept of a default page, which is a page that will be shown to the user when they view a Folder. It's a concept taken from Web sites where viewing a folder on a Web site shows a default page if one is present; often that default page's name is index.htm or index.html. If a Folder has a default page, then clicking the view tab will show that default page. If the Folder doesn't have a default page, then it'll show a folder listing of all the content in that Folder. 

Folders have two green tabs that represent slightly different views: contents and view. Actually, you may have already noticed that there's a contents tab accessible from any piece of content that you've added to the site; for example, when you were editing a document, the contents tab was there. That contents tab will always take you to the contents for that Folder.

Cut/Paste/Delete/Rename Contents of a Folder

The contents view of a Folder allows a user to perform a variety of tasks, such as move content, rename it, delete it, publish it, and change the order it's listed. You'll see a simple table of the Folder contents. Each row of the table shows the title of the content (plus an icon), the type, its size, when it was last modified, its current workflow status, and order selectors. 

1. Use the checkbox on the left to select the items you want to change. 

2. Use the options buttons across the bottom to select an action: Rename, Cut, Copy, Delete, and Change State. 

Note: You can apply these functions to multiple objects at once by selecting several checkboxes before clicking on an option button.
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For example, to quickly rename a piece of content, click that item's checkbox and then click Rename. This will open the rename form and allow you to rename the title of each item in that list. Click Save to have the changes take effect. 

The Cut and Copy buttons allow you to copy or move content between different Folders. 

The Delete button allows you to delete the item from Plone. Just like on your hard drive, if you copy, move, or delete a Folder, all the contents of the Folder will also be moved, copied, or deleted.

Setting a Folder’s Default View

When you create a new Folder and add pages or other items to it, the Folder displays a list of these objects. While you can make this view available to site visitors, you’ll usually want to create a default page that displays when visitors move to the Folder using the navigation.

1. Move to the Folder. (If you haven’t created a default page, create, save, and publish it now.) 

2. Click Display, and then click Choose Content Item As Default View.

3. Select the radio button for the page you want, and then click Save.

Project 4 – Creating a New Folder and Default Page

Move to a main area of the site that needs a new sub-navigation tab.  Add, save, and publish a new Folder. Then, create a main page for the new Folder and set it as the Folder’s default view.

Adding and Managing Users

NPower has created default users on your site. However, you should create a new user for each person who will add or edit content on the site. You may also want to specify roles or permissions for each user, or add them to a group that provides the permissions you want.

1. Log in as Administrator (user name is usually “admin”).

2. Click Site Setup, and then click Users and Groups Administration.

3. Click Add New User.

4. Fill out the form and click Register.

By default, new users can add and edit content only in their own “member folder.” An administrator or reviewer must move their content to public areas of the site and publish it.

Adding a User to a Group

The easiest way to provide access to a user is to add them to a group that NPower has set up for you, such as Administrators, Reviewers, or Editors. If you want a user to have a role throughout the site, add the user to a group.

1. Click Site Setup, and then click Users and Groups.

2. Click Show All, and then click the user’s name.

3. Click Group Memberships.

4. Select the box for the group you want the user to participate in, and then click Add User to Selected Groups.

Allowing Users to Add or Edit Content

You may want to allow users to add or edit content in an area of the site without making them a member of a group.

1. Move to the Folder where you want to permit access. (To provide access to the entire site, click Home.)

2. Click Contents. (This way, you will set permissions for the Folder rather than a single page.)

3. Click the Sharing tab.

4. Select users or groups, and then assign them the Owner role for the Folder.

Once a user has the Owner role in a Folder, he or she can add and edit items in that Folder and all subfolders.

Project 5 – Adding a User

Log in and navigate to the ‘Site Setup’ section.  There, go to ‘Users and Groups.’  Finally, select ‘add a new user,’ and fill out the request ‘form’ information. To allow the new user to edit and publish content, add the user to the Reviewers group.

Where To Go Next 

Web and print resources 

· Online Plone manual at http://npower.learnplone.org/.  NOTE: This manual covers Plone 2.0.  An updated site will soon be available at http://npower.learnplone.org.

· The development and community site for Plone at http://plone.org/
· The Definitive Guide to Plone, by Andy McKay. Available in print, or online at http://docs.neuroinf.de/PloneBook 

· Plone Content Management Essentials, by Julie Meloni
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